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1 Introduction

Congratulations for purchasing the Piccolo-II Integrating Sound Level Meter. This instrument
provides an innovative and cost effective solution for professional grade acoustical measurement.

1.1 Features

 Precision Integrating Sound Level Meter;
 A, C and Z simultaneous frequency weightings;
 Leq, Lmax, Lmin, Lpeak, SEL,
 10 Percentiles (L1%, L2%, L5%, L8%, L10%, L25%, L50%, L90%, L95% and L99%);
 Large dynamic range: 30 dBA to 130 dBZpk1;
 Slow or Fast SPL Time response;
 1/1 Octave spectrum;
 1/3 Octave spectrum2;
 400 lines FFT spectrum;
 16 MB memory for up to 198,948 records;
 Auxiliary input for external microphone;
 Large Li-Ion battery for up-to 48h operating time.

1 Using two ranges: Low : 30 dBA to 110 dBZpk, High 46 dBA to 130 dBZpk, at nominal sensitivity
2 1/3 octave spectrum available using Spectrum Analyzer software (Section 8.5)
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2 First Use

2.1 Unpacking

2.2 Instrument Components

Carrying Case

USB Cable Piccolo-II Instrument

Calibration Certificate

Display

Buttons

Overload
LED

USB
Connector

Charging
LED

Auxi Jack (1/8)

Reset
Button Tripod

Adapter
(1/4-20)

SN Label

Microphone
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2.3 Dimensions

2.4 Buttons

There are 3 buttons on the Piccolo-II to control the instrument. Icons displayed above each button
indicate the functions associated with a long-press and icons under the buttons indicate the
functions associated with a short-press.

14
4m

m
 (5

 5
/8

”)

59mm (2 5/16”)
18.5mm (23/32”)

13.2mm (0.52”)

“Short-Press” Functions
Change Data Display
Run/Stop “Single-Store” Measurement
Measurement Setup Select

“Long-Press” Functions
Measurement Setup
Run/Stop “Auto-Store” Measurement
Power ON/OFF
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2.5 Display Screen

1) Battery Level (contour blinking when charging)
2) Maximum Sound Pressure Level (SPL) Label
3) Minimum SPL Label
4) Average in progress (blinking)
5) Equivalent Level Label (Leq)
6) Live SPL Bar Graph (Right-most segment blinking on Under-Range, Left-most segment

blinking on Over-Load)
7) SPL Time-Weight Label (Fast or Slow)
8) dB Unit Label
9) Frequency Weighting Label (A, C or Z)
10) Sound Level (Leq, Live SPL, Lmax, Lmin, SEL, Lpeak);

Record Number;
Elapsed Time (mm:ss);
Overload (- or 1);
Battery %.

11) Additional Label: SPL, SEL, PEA (Lpeak), rEC (Record number), bAtt (Battery);
Under-Range (- or 1);

12) Time Label: visible when displaying Elapsed Time.

2.6 Overload Indication

The overload LED will blink for 1s when an overload occurs. If the overload occurs
during a measurement, the right-most segment of the SPL Bar Graph will blink. This
segment will keep blinking until another measurement is performed.

The overload threshold is set 1 dB below the upper limit of the dynamic range.

1

2 3 4 5

6

7

9

8

1011

12
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2.7 Power-Up

To power ON the instrument, press and hold the right-most button. At power-up, the display screen
displays the live SPL.

To power-up the instrument, perform a long-press on the right-most button. This
will power-up the instrument and display “Init” on the display during the warm-up
process (~1s).

2.8 Shut-Down

To shut-down the instrument, press and hold the right-most button until the display turns off.

When no measurement is in progress, the instrument will shut-down after 10 minutes of inactivity.

Long-Press
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3 Running a Measurement

There are two measurement modes available on the Piccolo-II: “Single-Store” and “Auto-Store”.

The Single-Store runs a single average period and stopes after the specified duration or when the
user stops the measurement.

The Auto-Store runs a series of average periods one after the other until the user stops the
measurement or until the memory is full.

3.1 Single-Store

To start a Single-Store measurement, perform a short-press on the center button.
This will display “run SGLE” on the display for 1s and start the measurement.

Once the measurement is started, the display automatically shows the Leq.
While the measurement is running, the “Avg” indicator will blink and the left-most
segments will rotate indicating a measurement in progress.

To stop the measurement, press the center button or simply wait for the
measurement duration to be elapsed.
When the measurement is over, the record number will be displayed for 1s and the
display will return to the Leq.

Short-Press

Press
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3.2 Auto-Store

To start an Auto-Store measurement, perform a long-press on the center button.
This will display “run AUTO” on the display for 1s and start the measurement.

Once the measurement is started, the display automatically shows the Leq.
While the measurement is running, the “Avg” indicator will blink and the left-most
segments will rotate indicating a measurement in progress.
Note that the left-most segments rotate to form an “O” shape in Auto-Store mode
whereas it forms a small “o” shape in Single-Store mode.

To stop the measurement, press the center button.
When the measurement is over, the record number will be displayed for 1s and the
display will return to the Leq.

Long-Press

Press
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4 Data Display

Each Data Display is accessible by performing a short-press on the right-most button. This will flip
through the following displays:

Leq : Equivalent sound level of the last record

Live SPL : Live sound pressure level

Lmax : Maximum SPL of the last record

Lmin : Minimum SPL of the last record

SEL : Sound Exposure Level of the last record

Lpeak : Peak sound level of the last record

Record : Number of the last record

Time : Duration of the last record

Dynamic Info : Overload and Under-Range indicators of the last record

Battery : Battery percent
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5 Measurement Setup

The measurement setup is accessible by performing a long-press on the left-most button. Another
long-press on the button changes the setup menu and a short-press on the button changes the
parameter value. To exit the menu, click on any of the two other buttons or wait 10s.

Record Duration : Flips through 1s, 10s, 1m, 5m, 15m and 60m. Note that these
durations can be changed using the software.

Calibration : Flips through 94 dB or 114 dB calibrator selection. A long-press on the
center button starts the calibration process. Refer to section XX for more information.

Input Range : Flips through “Low” and “High”. Refer to technical specifications for more
information on the input range.

Frequency Weighting : Flips through “A”, “C” and “Z” frequency weighting to display.
Note that “A”, “C” and “Z” global levels are always recorded regardless of this parameter.
The only exception are percentiles (LN%) which are only recorded for the selected
frequency weighting.

SPL Time Response : Flips through “Fast” and “Slow” time response for sound pressure
level exponential response.

FFT Mode : Flips through “OFF”, “Full”, “8000”, “4000”,  “2000”, “1000”, and “500”. The
FFT is 400 lines and spans a full bandwidth of 17.2kHz. The bandwidth can be reduced
using the “8000” to “500” modes to achieve higher frequency resolution.
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6 Calibrating

1) Insert the microphone in the calibration chamber of a microphone calibrator1

2) Perform a long press on the Setup button to enter the setup;
3) Perform another long-press on the setup button to get to the calibration menu;
4) Perform a short-click on the setup button to select the calibration level (94dB or 114 dB)

matching the calibrator reference level;

5) Turn the calibrator ON;
6) Perform a long-press on the RUN/STOP button to initiate the calibration process;
7) The calibration process takes 5s. During this period the display shows the measured SPL

and the “Avg” label blinks;

8) When the process is done, the display shows “done” indicating a success or “err” indicating
an error.

An error can occur if the calibration value is out of range. This can occur when the calibrator is not in
function or when the level selection (94-114) does not match the calibrator reference level.

Note that when an external signal source is connected on the auxiliary jack, the auxiliary input will
be calibrated. This will not affect the calibration value of the main microphone.

The calibration process can also be performed using the software. Refer to section 8.3.2 for more
information.

1 The microphone calibrator should be compliant to IEC 60942.
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7 Locking and Unlocking

To lock and unlock the Piccolo-II, press and hold all 3 buttons at the same time. When the instrument
gets locked or unlocked, it will display the following:

Locked

Unlocked
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8 Software

8.1 Download and Install

To download the software installer, use the following link:

www.softdb.com/software.php?piccolo-2

Computer Requirements
Item Minimum Requirements

Operating System Windows 7 or more

CPU Dual-Core at1.2 GHz

Memory 2 GB RAM

Hard drive 300 MB free hard disk space

Port USB 2.0

Display resolution 800 x 600

8.2 Software Modules

The software modules included in the Piccolo-II software installer and accessible in the Start Menu
are the following:

 Utility:         Configure the Piccolo-II and import records (Section 8.3)
 Data Manager:     Post-process measurement records (Section 8.4)
 Spectrum Analyzer:   Measure and analyze spectrum files (Section 8.5)
 Audio Recorder:    Record audio files using the Piccolo-II as a sound card (Section 8.6)

http://www.softdb.com/software.php?piccolo-2
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8.3 Utility Software

1) To open the software, click on “Piccolo-II Utility” from the Start Menu.

2) Connect a Piccolo-II instrument to the computer using the provided USB cable. Once
connected, the software should automatically detect it.

The left side of the interface shows the Instrument Panel and the right side shows the Setup and
Tools.

The Instrument Panel shows exactly what’s happening on the instrument itself. You can use the 3
software buttons as you would with the physical buttons. The display screen shows the same
information as on the physical instrument as well as the Overload LED.

The Setup and Tools shows the setup parameters of the instrument as well as additional tools

Setup and ToolsInstrument Panel
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8.3.1 Memory Download

1) Click on the “Load” button to load the records in memory;
2) Once the download is completed, a file save prompt will show to save the *.pic2 file on the

computer.
3) Once the file is saved, the Data Manager software (Section 8.4) is launched to view the data.

8.3.2 Calibration

1) Click on the “Calibration” button to launch the microphone calibration interface;
2) Insert the microphone in the calibration chamber of a microphone calibrator1;
3) Enter the calibrator reference Sound Pressure Level and Frequency;
4) Turn the calibrator ON;
5) Click on the “Start” button to start the calibration process;
6) After 5s the measurement stops and the sensitivity value is updated.

Note: If an external source is used with the auxiliary jack connector, the auxiliary jack will be
calibrated.

8.3.3 Calibration Certificate

Click on the “Certificate” button to view the factory calibration certificate of the Piccolo-II:

1 The microphone calibrator should be compliant to IEC 60942.
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Each Piccolo-II instrument is calibrated and tested at the factory following the procedures from IEC
61672-3 (2013) / ANSI/ASA S1.4-3 (2014) Electroacoustics – Sound Level Meters – Part 3: Periodic
Tests.

A paper copy of the calibration certificate is delivered with each instrument and the certification data
is stored in the instrument internal memory for software display. The Piccolo-II instruments can be
sent back to the factory for periodic testing. Contact info@softdb.com for more information.

Refer to section 12 for a specimen calibration certificate.

8.3.4 Clock Synchronisation

Click on the  button to synchronize the clock with the computer clock.

When the Piccolo-II clock indicates an offset of more than 10s compared to the computer clock, this
 icon will be displayed next to the clock in the software interface.

mailto:info@softdb.com


16

8.4 Data Analyzer Software

The “Data Analyzer” software module allows viewing recorded measurements data, save it to a file
and export it to a text file.

The main interface shows a time history graph of all recorded measurements. You can add a data
plot by clicking on “Add Data” from the “Edit” menu.

Drag the cursor on the graph to update the legend values.

You can zoom in/out on the graph using the magnifier buttons or using the mouse wheel or the
up/down keys. You can also manually edit the axis minimum and maximum labels to set the range
to a specific value.

You can move the time range by moving the scrollbar at the bottom, or by dragging the cursor on
the graph limits or by using the left/right keys.

Click on “Show Details” from the “View” menu to open the record details panel. This panel shows the
details of the record indicated by the cursor. Moving the cursor on the time history graph updates
the displayed information.
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Click on “Records Table” from the “View” menu to show the recorded measurements as a table. When
displaying the list, click on “History Chary” to go back to the time history graph. Note that displayed
data curves on the time history graph will appear as data columns in the list view. The selected row
in the list is linked to the cursor on the time history graph

Click on “Save” or “Save As” from the “File” menu to save the records in a *.pic2 file.

Click on “Export” from the “File” menu to export the data in a tab delimited file.

8.4.1 Trim Records

Click on “Trim to Time Range” from the “Edit” menu to keep only visible recordings from the History
chart. Be sure to save this new dataset as a new file.

8.4.2 Compute Longer Intervals

You can recompute longer intervals by clicking on the “Calculate Longer Intervals” from the “Edit”
menu. Note that only contiguous records will be considered; any discontinuity will remain.
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Note that intervals are aligned on hours.

8.4.3 Noise Dose Calculation

Click on “Calculate Noise Dose” from the “Edit” menu to calculate a noise dose according to ANSI
S1.25 or ISO 1999.



19

8.5 Spectrum Analyzer Software

The Spectrum Analyzer software allows recording 1/1 octave, 1/3 octave and FFT records
simultaneously. All spectra definitions are recorded simultaneously.

1) Click on the “Start” button to start a measurement;
2) Click on the “Stop” button to stop the measurement.

The “File” menu allows:

 Opening a *.sp2 file;
 Saving a *.sp2 file;
 Exporting a spectrum as a text file.

The “View” menu allows viewing the current spectrum as:

 “Live” or “Averaged”;
 “1/1 Octave”, “1/3 Octave” or “FFT”;
 “A”, “C” or “Z” frequency weighting.

The “Piccolo-II” menu allows to configure the relevant parameters for spectral measurements.

Note: The FFT resolution and bandwidth follows the Piccolo-II FFT mode. Refer to section 5 for more
information.
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8.6 Audio Recorder Software

The Audio Recorder software allows using the Piccolo-II as a sound card to record *.wav files.

1) Click on the “Start” button to start a recording;
2) Click on the “Stop” button to stop the recording;
3) Upon stopping the recording, the software prompts to save the recorded file.

On the audio recording interface, the graph shows the time signal and the vertical fill-bar shows the
dynamic range.

If an external source is used with the auxiliary jack connector, the auxiliary jack will be used as the
signal source to be recorded.
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9 Technical Specifications

Sound Level Meter

Standards

IEC 61672-1 (2013) Class 2, Group X;
ANSI S1.4-1 (2014) Class 2, Group X;

ANSI S1.43 (2007) Type 2;
IEC 60651 (1979), Amd.1(1993-02), Amd.2(2000-10) Type 2, Group X

Averaging Exponential and Linear

Time Weightings Slow or Fast

Frequency Weightings A, C and Z

Input Ranges Low or High

Sampling Rate 44.1 kHz

Measured Metrics
Leq, Lmax, Lmin, Lpeak, SEL,

LN% (1%, 2%, 5%, 8%, 10%, 25%, 50%, 90%, 95%, 99%)

Peak Maximum Level Low Range: 110 dBZpk, High Range: 130 dBZpk

Under-Range Level Low Range: 30 dBA, High Range: 46 dBA

Electrical Noise Level Low Range: 24 dBA, High Range: 40 dBA

Total Noise Level Low Range: 30 dBA, High Range: 40 dBA

Resolution 0.1 dB

Microphone Nominal Sensitivity -35dB ±3 dB, ref 1V/Pa (17.78 mV/Pa)

Spectrum Analyzer

Standards
IEC 61260-1 (2014) Class 2, Group X (1/1 Octave), Group Z (1/3 Octave);

ANSI S1.11-1 (2014) Class 2, Group X (1/1 Octave);

Averaging Linear (Leq)

1/1 Octave Spectrum 31.5 Hz to 8 kHz

1/3 Octave Spectrum (PC software only) 20 Hz to 16 kHz

FFT Spectrum 400 lines, 6 bandwidths

FFT Bandwidth

Full: 17.2kHz (43.1Hz)
8000: 8.62kHz (21.5Hz)
4000: 4.31kHz (10.8Hz)
2000: 2.15kHz (5.39Hz)
1000: 1.08kHz (2.69Hz)

500: 539Hz (1.35Hz)

Timing

Display Refresh Rate 0.1s

Record Duration Resolution 1s

Record Duration Pre-sets 1s, 10s, 1m, 5m, 15m, 60m (can be redefined from 1s to 1h)

Real-Time Clock Resolution 1s

Recording

Recording Modes Single-Store or Auto-Store

Align on Real-Time Clock Single-Store: No, Auto-Store: Yes

Recording Data All Global Metrics (A, C and Z), LN% (A, C or Z), 1/1 Octave, FFT (optional)

Memory Capacity Without FFT: 198 948 records, With FFT: 18 798 records
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Auxiliary Input

Connector Phone Jack 1/8” (Female, Mono)

Voltage Range Low Range: ±0.16Vpk, High Range: ±1.6Vpk

Routing Automatic upon jack plug connection

Sensitivity Independent value for microphone and auxiliary input

Environmental

Operating Temperature 0°C to 40°C

Storage Temperature -10°C to 50°C

Power

Power 70 mW (Running), 0.3 mW (Sleeping)

Battery Life 48 h (Running), > 6 months (Sleeping)

Battery Charge 5V (USB-powered)

Physical

Dimensions 144mm x 59mm x 18.5mm (5 5/8” x 2 5/16” x 3/4”)

Weight 115g (4 Oz.)

Accessories

Windscreen 35mm x 25mm (12mm hole)

USB Cable 0.9m (3’) A to Micro-B

Carrying Case 213 mm x 183 mm x 62 mm (8.4” x 7.2“ x 2.45”)

Calibration Certificate Tested in accordance with procedures from IEC 61672-3 (2013)
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10 Measuring to IEC 61672-3

10.1 Reference Sound Pressure Level

The reference sound pressure and frequency are 94.0 dB at 1 kHz.

10.2 Reference Level Range

The reference level range is “Low”.

10.3 Corrections for Acoustic Tests

10.3.1 Free-Field and Pressure Response

The Piccolo-II is designed to have a flat response (±0 dB) in a 0° free-field sound field. When in a
pressure field such as in the calibration chamber of a calibrator, the following pressure response
must be taken into account. The pressure response and correction data are given for calibrator
model 4226 from B&K.
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Freq. (Hz)
0° Free-Field

Response (dB)
0° Free-Field

Corrections (dB)

Pressure Response
in Calibrator

Chamber (dB)

0° Free-Field
Corrections in

Calibrator
Chamber (dB)

Uncertainty
(dB)

31.5 0.0 0.0 0.3 -0.3 0.3

63 0.0 0.0 0.6 -0.6 0.3

125 0.0 0.0 0.7 -0.7 0.3

250 0.0 0.0 0.6 -0.6 0.3

500 0.0 0.0 0.4 -0.4 0.3

1000 0.0 0.0 0.0 0.0 0.3

2000 0.0 0.0 0.3 -0.3 0.3

4000 0.0 0.0 0.8 -0.8 0.5

8000 0.0 0.0 -0.5 0.5 0.5

16000 0.0 0.0 -14.9 14.9 1.0

10.3.2 Directivity Response

The figure below shows the directional response of the Piccolo-II with respect to the sound incidence
angle.

Incidence angle (°)
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10.3.3 Effect of Windscreen

The figure below shows the effect of the supplied windscreen (35mm x 25mm, 12mm hole).

10.4 Upper and Lower Boundaries of Linear Operating Ranges

10.4.1 Upper Boundary of Linear Operating Range for the “Low” range setting

Frequency
Weighting

Frequency
(Hz)

Upper Boundary
(dB[A,C,Z], rms)

Upper Boundary
(dB[A,C,Z], peak)

A 31.5 67.6 70.6

A 500 103.8 106.8

A 1000 107.0 110.0

A 4000 108.0 111.0

A 8000 105.9 108.9

C 31.5 104.0 107.0

C 500 107.0 110.0

C 1000 107.0 110.0

C 4000 106.2 109.2

C 8000 104.0 107.0

Z 31.5 107.0 110.0

Z 500 107.0 110.0

Z 1000 107.0 110.0

Z 4000 107.0 110.0

Z 8000 107.0 110.0
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10.4.2 Upper Boundary of Linear Operating Range for the “High” range setting

Frequency
Weighting

Frequency
(Hz)

Upper Boundary
(dB[A,C,Z], rms)

Upper Boundary
(dB[A,C,Z], peak)

A 31.5 87.6 90.6

A 500 123.8 126.8

A 1000 127.0 130.0

A 4000 128.0 131.0

A 8000 125.9 128.9

C 31.5 124.0 127.0

C 500 127.0 130.0

C 1000 127.0 130.0

C 4000 126.2 129.2

C 8000 124.0 127.0

Z 31.5 127.0 130.0

Z 500 127.0 130.0

Z 1000 127.0 130.0

Z 4000 127.0 130.0

Z 8000 127.0 130.0

10.4.3 Lower Boundary of Linear Operating Range for the “Low” range setting

Frequency Weighting Frequency (Hz) Linearity Lower Limit (dBA, rms)

A 31.5 30.0

A 1000 30.0

A 8000 30.0

10.4.4 Lower Boundary of Linear Operating Range for the “High” range setting

Frequency Weighting Frequency (Hz) Linearity Lower Limit (dBA, rms)

A 31.5 46.0

A 1000 46.0

A 8000 46.0

10.4.5 Starting Point for Testing Boundaries of Linear Operating Ranges

The starting point at which to begin tests of level linearity deviation is 94 dB (1Pa, rms) at 1kHz. This
starting point is used for both “Low” and “High” dynamic range settings.

Frequency Weighting Frequency (Hz) Freq. Weight (dB) Reference Starting Point
(dBA)

A 31.5 -39.4 54.6

A 1000 0.0 94.0

A 8000 -1.1 92.9
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10.5 Performing Electrical Tests

10.5.1 Inserting Electrical Signals

Inserting electrical signals into the Piccolo-II is performed by the means of the auxiliary input. The
auxiliary input requires a 1/8” phone plug and must be a mono type (no stereo). The signal should
be applied on the tip and the ground should be on the sleeve.

Note that when using an electrical input it is recommended to use the Piccolo-II in stand-alone
configuration (without USB connection to a PC) to avoid ground loop noise. If the instrument is
tested using a USB connectivity to a PC, make sure to use appropriate ground isolation.

10.5.2 Specifications Adjustment

The technical specifications are set for a nominal microphone sensitivity of -35dB (ref 1V/Pa). The
variation in sensitivity from one instrument to another is ±3.0 dB. If the sensitivity of the instrument
under test differs from the nominal sensitivity, an adjustment should be applied to the specifications
of the instrument corresponding to the sensitivity offset.

𝐴𝑑𝑗𝑢𝑠𝑡𝑚𝑒𝑛𝑡 (𝑑𝐵) = −35(𝑑𝐵)−𝑀𝑖𝑐𝑟𝑜𝑝ℎ𝑜𝑛𝑒 𝑆𝑒𝑛𝑠𝑖𝑡𝑖𝑣𝑖𝑡𝑦 (𝑑𝐵)

10.5.3 Calibration

Calibrate the microphone using an IEC 60942 Class 1 sound pressure calibrator at the reference
sound pressure and frequency of 94.0 dB at 1 kHz.

The microphone calibration procedure can be performed on the instrument (see section 6) or using
the equivalent software interface (see section 8.3.2).

The nominal microphone sensitivity is -35 dB (ref 1V/Pa) and the tolerance from one instrument to
another is ±3.0 dB.

10.5.4 Adjusting Sensitivity for the Auxiliary Input

There are two sensitivity settings for the Piccolo-II, one for the microphone and the other for the
auxiliary input. The auxiliary input is used mainly for inserting electric signals during calibration and
certification tests. For convenience, a separate sensitivity is provided for the auxiliary input for
specific applications such as using an external microphone (not covered by this user guide). Since
the instrument knows if a jack is inserted, it can select the appropriate sensitivity. When measuring
to IEC-61672-3, one must set the same sensitivity for the microphone and auxiliary input using the
following procedure:

1) Calibrate the microphone (see section10.5.3);
2) Using the software, click on the “Calibrate” button to open the calibration interface;
3) On the calibration interface, make sure the window title is “Microphone Calibration”;
4) Identify the sensitivity field in mV/Pa and write it down;
5) Insert the 1/8” phone plug in the auxiliary input to force the input change;
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6) On the calibration interface, make sure the window title is “Auxiliary Input Calibration”;
7) Identify the sensitivity field in mV/Pa and write the same sensitivity as for the microphone.
8) Click OK.

10.6 Self-Generated Noise

Self-generated noise is measured using Leq,30s.

10.6.1 Total Self-Generated Noise (Acoustical and Electrical)

Frequency Weighting Low Range High Range

A 30 40

C 39 42

Z 42 47

10.6.2 Electrical Self-Generated Noise

Frequency Weighting Low Range High Range

A 24 40

C 24 41

Z 28 45
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11 Glossary

Time-Weighted Sound Pressure Level (SPL)

Expressed in dB, the SPL represents the sound level of the running time-weighted average of a sound
pressure signal observed at a specific time.

𝐿𝑊(𝑡) = 10𝑙𝑔 ൥
1
𝜏𝑊

∙
∫ 𝑝2(𝑡)𝑒−𝑡 𝜏𝑊⁄ 𝑑𝑡𝑡
−∞

𝑝02
൩

 W is the time-weight indication, F for Fast and S for Slow
 τW is the time constant for the time-weight 0.125s for Fast and 1s for Slow
 p(t) is the sound pressure signal;
 p0 is the reference sound pressure (2x10-5 Pa.)

Equivalent Continuous Sound Level (Leq)

Expressed in dB, the Leq,T represents the equivalent continuous sound level of a sound pressure
signal observed for a specific time interval.
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1
𝑇
∙
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𝑡−𝑇

𝑝02
൩

 T is the averaging time interval;
 p(t) is the sound pressure signal;
 p0 is the reference sound pressure (2x10-5 Pa.)

Peak Sound Level (Lpk)

Expressed in dB, the Lpk represents the sound level of the maximum of a squared sound pressure
signal observed for a specific time interval.

𝐿𝑝𝑘 = 10𝑙𝑔 ቈ
𝑚𝑎𝑥(𝑝2(𝑡), T)

𝑝02
቉

 T is the observation time interval;
 p(t) is the sound pressure signal;
 p0 is the reference sound pressure (2x10-5 Pa.)

Maximum and Minimum Sound Pressure Level (Lmax, Lmin)

Expressed in dB, the Lmax and Lmin represent the maximum and minimum time-weighted sound
pressure level observed for a specific time interval.



30

Percentiles (LN%)

Expressed in dB, the Percentiles represent the time-weighted sound pressure level which is
exceeded N% of a specific time interval. Typical percentiles are L1%, L5%, L10%, L50%, L90%, L95%
and L99%.

Sound Exposure Level (SEL or LE)

Expressed in dB, the SEL (or LE) represents the total energy level of a sound pressure signal observed
for a specific time interval.

𝐿𝐸, 𝑇 = 10𝑙𝑔 ൥
∫ 𝑝2(𝑡)𝑑𝑡𝑡
𝑡−𝑇

𝑝02
൩

 T is the averaging time interval;
 p(t) is the sound pressure signal;
 p0 is the reference sound pressure (2x10-5 Pa.)

Frequency Weighting (A, C, Z)

The A, C and Z frequency weightings refer to signal filters applied to the sound pressure signal. The
figure below shows the frequency response of each filter.

Note that all sound level metrics (SPL, Leq, SEL, Lpk, Lmax, Lmin, and LN%) can be expressed with a
specific frequency weighting. For example, the LAeq represents the A-weighted Equivalent
Continuous Sound Level.
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12 Specimen Calibration Certificate
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13 FAQ

Can I power the Piccolo-II from an external battery?

Yes, the Piccolo-II can be powered from an external battery but it’s important to mention that not
every USB battery will work.

The “smart” USB batteries widely available on the Internet are meant to charge a cellphone battery
and disconnect itself once the battery is fully charged. Since the Piccolo-II is already full when it’s
connected to such a battery, the battery disconnect itself and does not provide any power.

Thus, the recommended battery is a simple battery pack with battery voltage directly on the USB
power pins such as this one:

Using 4x AA batteries (4x 3200 mAh) should provide 3-4 days of extended battery life before the
internal battery starts being used.

Important: The maximum voltage on the USB connector is 7V.

Note: No technical support will be provided on the use of an external battery. The warranty does not
cover any damages caused by the use of an external battery.

Is the Piccolo-II weatherproof?

No, the Piccolo-II is not weatherproof. Exposing the Piccolo-II to water can damage the microphone
and its internal electronics. Water damages are not covered by the warranty.
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14 Warranty

Soft dB warrants this instrument to be free of defects in parts and workmanship for one year from
date of shipment (a six-month limited warranty applies on sensors and cables). Please contact us at
info@softdb.com should it become necessary to return the instrument for service during or beyond
the warranty period. A return authorization (RMA) must be issued before any product is returned to
Soft dB. The sender is responsible for shipping charges, freight, insurance and proper packaging to
prevent damage in transit. This warranty does not apply to defects resulting from actions of the user
such as misuse, improper wiring, operation outside of specification, improper maintenance or repair,
or unauthorized modifications. Soft dB specifically disclaims any implied warranties or
merchantability or fitness for a specific purpose and will not be liable for any direct, indirect,
incidental or consequential damages. Soft dB’s total liability is limited to repair or replacement of the
product. The warranty set forth is inclusive and no other warranty, whether written or oral, is
expressed or implied.

mailto:info@softdb.com
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